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1

1 Introduction

1.1 Add-onModule RF-/STEEL AISC
TheAmerican Institute of Steel Construction's Specification for Structural Steel Buildings [1] describes
the design and construction of steel structures in theU.S. In this Specification, the design according
to the provisions for load and resistance factor design (LRFD) and to the provisions for allowable
strength design (ASD) is regulated. Both types of design can be performed with the powerful
add-on modules RF-STEEL AISC (for RFEM) and STEEL AISC (for RSTAB).

In the following, the modules of the two main programs are described in one manual and are
referred to as RF-/STEEL AISC.

RF-/STEEL AISC performs all typical designs of strength and stability, as well as for the deflections.
The program takes into account various load combinations for the allowable strength design or for
the load and resistance factor design. Classifying sections for local buckling into the appropriate
types (slender, nonslender, compact, noncompact) is important for the design of members subject
to axial compression and/or flexure. By this classification, the effects are accounted for where local
buckling reduces the load capacity. RF-/STEEL AISC determines the limiting width-to-thickness
ratios of compressed parts and carries out the classification automatically.

For the stability analysis in RF-/STEEL AISC, the user can determine for every single member or
set of members whether buckling and torsional buckling is possible. Furthermore, the effective
lengths can bemodified when designing per the effective length method. Alternatively, the direct
analysis method can be considered with member or set of member stiffness reductions in RFEM
or RSTAB. Lateral restraints of members allow for a realistic representation of the structural model.

Formodelswith slender cross-sections, the serviceability limit state has become an essential aspect
of the design. The deflection limits are preset according to the Specification, but can be modified.
If necessary, the reference lengths and precambers of members can be adjusted as well.

The program features an option to optimize sections and to export them to RFEM or RSTAB. By
means of design cases, it is possible to design separate structural components of complex models
or to analyze alternatives with different sections or materials.

Since RF-/STEEL AISC is integrated in the main program, the design relevant input data is preset
when the module is opened. After the analysis, the design results can be evaluated graphically in
the work window of RFEM or RSTAB. Last but not least, it is possible to keep records of the analysis
in the global printout report which includes the internal forces and the design results.

We hope you will enjoy working with RF-/STEEL AISC.

Your DLUBAL team

1.2 Using theManual
Topics like installation, graphical user interface, results evaluation, and printout are described in
detail in the manuals of the main programs RFEM and RSTAB. The present manual focuses on
typical features of the RF-/STEEL AISC add-on module.

The descriptions in this manual follow the sequence and structure of themodule's input and result
windows. In the text, the describedbuttons are given in square brackets, for example [Viewmode].
At the same time, they are pictured on the left. Expressions appearing in dialog boxes, windows,
and menus are set in italics to clarify the explanations.

At the end of the manual, you can find the index. If you cannot find what you are looking for, go
to the Knowledge Base where you can search for the solution of the problem. Or consult the FAQs
on our website. Moreover, the design according to AISC is demonstrated in a recorded Webinar.

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base
https://www.dlubal.com/en/support-and-learning/support/faq
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1.3 Starting RF-/STEEL AISC

RFEM and RSTAB provide the following options to open the RF-/STEEL AISC add-on module.

Menu
To start the program from the menu bar, select

Add-onModules → Design - Steel → RF-/STEEL AISC.

Figure 1.1: Menu Add-onModules→Design - Steel→ RF-STEEL AISC

Navigator
You can also start the add-on module in the Data navigator by selecting

Add-onModules → RF-/STEEL AISC.

Figure 1.2: Data navigator Add-onModules→ RF-STEEL AISC
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2 Input Data
When you have started the add-on module, a new window appears. In this window, a Navigator
is displayed on the left. It manages the different window that can be currently selected. The
drop-down list above the navigator contains the design cases (see Chapter 7.1, page 55).

The design-relevant data is to be defined in several inputwindows. When you open RF-/STEEL AISC
for the first time, the following parameters are imported automatically:

• Members and sets of members

• Load cases, load and result combinations

• Materials

• Cross-sections

• Effective lengths

• Internal forces (in background, if calculated)

To select a window, click the corresponding entry in the navigator. To set the previous or next
input window, use the buttons shown on the left. You can also use the function keys to select the
next [F2] or previous [F3] window.

[OK] saves the results. Thus, you quit RF-/STEEL AISC and return to RFEM or RSTAB. To exit the
add-on module without saving any changes, click [Cancel].

2.1 General Data

In the 1.1 General DataWindow, you can select the objects and the loading relevant for the design.
The two tabs manage the load cases, load combinations, and result combinations for the different
types of design.

Figure 2.1: Window 1.1 General Data
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Design of

Figure 2.2: Design of members and sets of members

The design can be carried out forMembers as well as for Sets of Members. If you want to design
only selected objects, clear the All check box. Then you can access the text boxes and enter the
numbers of the relevant members or sets of members. The [Delete] button clears the list of preset
numbers. The [Select] button enables you to define the objects graphically in the work window of
RFEM or RSTAB.

When you design a set of members, the program determines the extreme values of the analyses
of all members contained in the set of members and takes into account the boundary conditions
of connected members for the stability analysis. The results are shown in Windows 2.3 Designs by
Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List by Set of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM or
RSTAB appears. There you can specify the parameters of the set of members.

Design According to

Figure 2.3: Design options

The list box options control whether the design is performed according to the provisions for load
and resistance factor design (LRFD) or to the provisions for allowable strength design (ASD).

There are design methods available for the current version of ANSI/AISC 360-16 [1]. If required,
one of the previous versions of this Specification dated from 2010 or 2005 can be selected for the
design.

Comment
In this text box, you can enter notes, for example to describe the selected design method or the
current design case.
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2.1.1 Ultimate Limit State

Figure 2.4: Window 1.1 General Data, tab Ultimate Limit State

Existing Load Cases and Combinations
This column lists all load cases, load combinations, and result combinations that have been created
in RFEM or RSTAB.

To transfer selected items to the Selected for Design list on the right, click . Alternatively, you
can double-click the items. To transfer the complete list to the right, click .

To select several items at once, click them while pressing the [Ctrl] key – as common for Windows
applications.

If a load case is highlighted in red, it cannot be designed. This happens when a load case has no
loads or if it contains only imperfections (see Figure 2.5).

At the end of the list, several filter options are available. They help you to assign the items by load
case, load combination, or action category (e.g. LRFD, ASD). The buttons next to the text box have
the following functions:

Selects all load cases in the list

Inverts the selection of load cases

Table 2.1: Buttons in Ultimate Limit State tab

Selected for Design
The column on the right lists the load cases, load and result combinations selected for design. To
remove an item from the list, select it and click . You can also double-click the item. To transfer
the entire list to the left, click .

Result combination

The design of an enveloping max/min result combination, RC, is faster than the design of all
contained load cases and load combinations. However, the influence of the contained actions is
difficult to check afterwards.
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2.1.2 Serviceability Limit State

Figure 2.5: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This section lists all load cases, load combinations, and result combinations that have been created
in RFEM or RSTAB.

Selected for Design
You can add or remove load cases, load and result combinations as described in Chapter 2.1.1.

The limit values of the deflections are preset in the Details dialog box (see Figure 3.3, page 31). To
adjust those values, click the [Details] button.

In the 1.11 Serviceability Data Window, you can specify the reference lengths of the deflection
analysis (see Chapter 2.11, page 27).
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2.2 Materials
This window consists of two parts: The upper table lists all materials created in RFEM or RSTAB. The
Material Properties section below shows the characteristics of the current material, i.e. the table
row which is selected above.

Figure 2.6: Window 1.2 Materials

Materials that will not be used in the design appear gray in color. Materials that are not allowed
are highlighted in red. Modified materials are displayed in blue.

The material properties required to determine the internal forces (Main Properties) are described
in Chapter 4.3 of the RFEMmanual and Chapter 4.2 of the RFEMmanual. The material properties
required for design (Additional Properties) are stored in the global material library. These values
are preset.

To adjust the units and decimal places of the material properties and stresses, select Settings →
Units and Decimal Places from the menu bar of the module (see Chapter 7.3, page 59).

Material Description
The materials defined in RFEM or RSTAB are preset, but you can always modify them: Click the
material in column A, and then click the button or press the function key [F7] to open the
material list.

Figure 2.7: List of materials
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According to the design concept of the Specification [1], only materials of the ASTM Steel category
are available in the list.

When you have imported a material, the design-relevantMaterial Properties are updated.

As a matter of principle, the material properties cannot be edited in the RF-/STEEL AISC module.

Material Library
Alternatively, you can use the material library to change a material. To open the library, select

Edit → Material Library

or use the [Library] button.

Figure 2.8: Dialog boxMaterial Library

In the Filter section, ANSI/AISC 360-16 is the default Standard. Select the material grade that you
want to use for the design in theMaterial to Select list. You can check the corresponding properties
in the dialog section below.

Click [OK] or press [ ] to transfer the selected material to Window 1.2 of RF-/STEEL AISC.

Chapter 4.3 of the RFEM manual and Chapter 4.2 of the RSTAB manual describe in detail how
materials can be filtered, added, or rearranged.

In the library, you can also select materials of categories Cast Iron and Stainless Steel. Be aware that
those materials are not covered by the design concept of the Specification [1].
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2.3 Cross-Sections

This windowmanages the cross-sections used for design. In addition, the module window allows
you to specify parameters for the optimization.

Coordinate System

The sectional coordinate system yz of RF-/STEEL AISC corresponds to the one of RFEM or RSTAB:
The y-axis represents the strong principal axis of the cross-section, the z-axis is its weak axis. This
coordinate system is used for both the input data and the results.

Figure 2.9: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM or RSTAB are preset with their material numbers.

If you want to modify a cross-section, select the entry in column B. Click the button or in
the box, or press the function key [F7] to open the cross-section table of the current cross-section
type (see Figure 2.10).

In this dialog box, you can select a different cross-section. To select a different section category,
click to access the global library of cross-sections.

Chapter 4.13 of the RFEMmanual and Chapter 4.3 of the RSTABmanual describe how sections can
be selected from the library.

You can directly enter the new cross-section description in the text box. If the entry is listed in the
database, RF-/STEEL AISC imports the cross-section parameters.

A modified cross-section will be highlighted in blue.

If the cross-section in RF-/STEEL AISC is different from the one of RFEM or RSTAB, both sections
are displayed in the graphic area. The designs will then be performed with the internal forces of
RFEM/RSTAB for the section defined in RF-/STEEL AISC.
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Figure 2.10: Rolled I-sections in cross-section library

Cross-Section Type
The program displays the type of cross-section that will be used for the classification according to
[1] Section B4.

Max. Design Ratio
This column is shown only after the calculation. It is useful for the optimization: By means of the
design ratios and colored relation scales, you can see which cross-sections are little utilized and
thereby oversized, and overloaded and for this reason undersized.

Optimize
It is possible to optimize every cross-section from the library. The program searches the cross-sec-
tion that comes as close as possible to a user-defined maximum utilization ratio. You can specify
this maximum ratio in the Details dialog box (see Figure 3.5, page 34).

To optimize a cross-section, open the drop-down list in column D (resp. E) and select From current
row. Recommendations on the optimization can be found in Chapter 7.2 on page 57.

Remark
This column shows remarks as footers. They are explained below the cross-section list.

Member with Tapered Cross-Section
For tapered members with different cross-sections at the member start and member ends, the
module displays both section numbers in two rows, according to the definition in RFEM or RSTAB.

RF-/STEEL AISC also designs tapered members, provided that the section at the member start
has the same number of stress points as the section at the member end. If the two sections have
different numbers of stress points, the intermediate values cannot be interpolated. In this case,
the calculation is neither possible in RFEM/RSTAB nor in RF-/STEEL AISC.
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The stress points including their numbering can be checked graphically: Select the cross-section
in Window 1.3 and click the [Info] button. The dialog box shown in Figure 2.11 appears.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can check on the cross-section properties, stress
points, and c/t-parts.

Figure 2.11: Dialog box Info About Cross-Section

The buttons below the cross-section graphic have the following functions:

Click the buttons find detailed information on the Stress points (centroidal distances, statical
moments of area, warping constants etc.) or c/t-Parts, respectively.

Figure 2.12: Dialog box Stress Points of W 21x101
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2.4 Intermediate Lateral Restraints

InWindow1.4, you can define lateral restraints formembers. In RF-/STEEL AISC, this kind of support
acts perpendicular to the z-axis of the cross-section (the minor axis, see Figure 2.11). Thus, you
can manipulate the effective lengths of the members for the stability design concerning flexural
buckling and lateral-torsional buckling.

Figure 2.13: Window 1.4 Intermediate Lateral Restraints

In the upper table, you can assign up to nine lateral restraints to eachmember. The Settings section
below shows a column overview for the member selected above.

To define the restraints of a specific member, select the Lateral Restraints check box in column A.
Then the other columns will be accessible where you can enter the parameters. To graphically
select the member, click .

In column B, you can select the Restraint Type from the drop-down list. A lateral and torsional
restraint is preset. It is also possible to place intermediate restraints at the lower or upper flanges.
The User-Defined option allows you to specify the restraint parameters individually (support in
direction of member axis y, restrained about longitudinal member axis x, eccentricity of support)
in the Settings section.

In column D, you can specify the Number of the intermediate restraints. Depending on the specifi-
cation, one or more of the following Intermediate Lateral Restraints columns will be available for
the definition of the x-locations.

When the Relatively (0 ... 1) check box is activated, you can define the support points by their
relative spacings. The positions of the intermediate restraints result from the member length and
the relative distances from the member start. When you clear the Relatively (0 ... 1) check box, you
can define the absolute distances.
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2.5 Effective Lengths - Members
This window controls the effective lengths which are relevant when designing per the effective
length method. This approach is described in [1] Appendix 7. Alternatively, the direct analysis
method can be considered by reducing member stiffnesses in RFEM or RSTAB (see article in the
Knowledge Base on our website).

Window 1.5 consists of two parts. The upper table presents a summary of all length factors of buck-
ling, torsional buckling, and lateral-torsional buckling as well as the respective member lengths.
The effective lengths defined in RFEM or RSTAB are preset. In the Settings section, additional
information about the member selected in the upper table is given.

You can make any changes in the upper table as well as in the Settings tree.

Click to select a member graphically and show its row.

Figure 2.14: Window 1.5 Effective lengths - Members

The effective lengths for buckling about the weak z-axis and torsional as well as lateral-torsional
buckling are aligned automatically with the settings of Window 1.4 Intermediate Lateral Restraints
(see Chapter 2.4). If intermediate lateral restraints divide the member into segments of different
lengths, no values are displayed in the table columns G, J, and L.

You can enter the effective lengths manually in the table and in the Settings tree, or define them
graphically in the work window by clicking the button. The button is active when you place the
cursor in the text box (see Figure 2.14).

The Settings tree includes the following parameters:

• Cross-Section

• Length of the member

• Buckling possible for the member (cf. column A)

• Buckling about Major Axis y Possible (cf. columns B to D)

• Buckling about Minor Axis z Possible (cf. columns E to G)

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001309
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• Torsional Buckling Possible (cf. columns H to J)

• Lateral-Torsional Buckling Possible (cf. columns K and L)

The table controls forwhichmembers an analysis of buckling, torsional or lateral-torsional buckling
is to be performed. In addition, the Effective Length Factor can be adjusted for the respective
designs. If you modify the factor, the equivalent member length is adjusted automatically, and
vice versa.

You can also define the effective length of a member in a separate dialog box. To open it, click the
button below the upper table.

Figure 2.15: Dialog box Select Effective Length Factor

In this dialog box, the Theoretical or Recommended values of the factor, K, can be defined that are
to be assigned to the selected member. The recommended values are described in [1] Appendix 7,
Table C-A-7.1. For each direction, you can also select one of the theoretical Euler buckling modes
or apply a User-defined factor.

If an eigenvalue analysis has been performed in the RF-STABILITY or RSBUCK add-on module, you
can import the Bucklingmode in order to determine the relevant factor.

Buckling Possible
The stability analysis for flexural and lateral-torsional buckling requires compressive forces to be
included. Members for which this is not possible due to their member types (tension members,
elastic foundations, rigid couplings) are disabled by default. The corresponding rows are dimmed,
and a note appears in the Comment column.

The Buckling possible check boxes in table row A and in the Settings tree allow you to control the
stability analyses: They determine whether the analyses for a member are to be performed or not.
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Buckling About Axis y / Buckling about Axis z
The Possible columns control whether there is a buckling risk about the y-axis and/or z-axis. Those
axes represent the local member axes, where the y-axis is the strong and the z-axis is the weak
member axis. You can freely define the effective length factors, Ky, and Kz, for buckling about the
strong or the weak axis.

You can check the position of themember axes in the cross-section graphic in the 1.3Cross-Sections
Window (see Figure 2.9, page 11). To access the RFEMor RSTABworkwindow, click the [ViewMode]
button. There you can display the local member axes by using the shortcut menu of the member
or the Display navigator.

Figure 2.16: Displaying member axes in Display navigator of RFEM

If buckling is possible about one or both member axes, you can enter either the effective length
factors, K, (columns C and F) or the effective lengths, KL, (columns D and G). The same is possible
in the Settings tree.

When you specify the effective length factor, K, the program determines the effective length, KL,
by multiplying the length with the effective length factor. The K and KL boxes are interactive.

To define the effective lengths graphically in the work window of RFEM or RSTAB, click . This
button becomes available when you place the cursor in a KL box (see Figure 2.14).

Alternatively, the parameters concerning buckling can be defined via the member lengths, L. This
option is controlled by the settings in the Details dialog box, tab Stability (see Figure 3.2, page 30).
When the option is set as seen in the image to the left, the titles of columns D and G will change
to L each so that the real member lengths can be defined (instead of the buckling lengths, K*L).

Torsional Buckling
Column H controls whether a torsional buckling design is to be performed. The effective length
factors, Kx, and the torsional buckling lengths, KxLx, can be defined in columns I and J. The x-axis
represents the center line of a member.
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Member axes

L.T.B.
Column K controls whether a lateral-torsional buckling analysis is to be carried out.

To determine Mcr by the eigenvalue calculation method, an internal member model with four
degrees of freedom is created. These degrees must be defined by the factors kz and kw. By
combining those two factors, you can define the support conditions for lateral-torsional buckling,
e.g. lateral and torsional restraint.

Effective Length Factor kz

The factor, kz, controls the lateral displacements uy and the rotations 𝜑z at both member ends.

kz = 1.0 restrained against lateral displacement uy on both member ends

kz = 0.7le restrained against displacement uy on both ends and restraint about z left

kz = 0.7ri restrained against displacement uy on both ends and restraint about z right

kz = 0.5 restrained against displacement uy and restraint about z on both member ends

kz = 2.0le restrained against displacement uy and restraint about z left; right end free

kz = 2.0ri restrained against displacement uy and restraint about z right; left end free

Warping Length Factor kw

The factor, kw, controls the torsion about the longitudinal axis, 𝜑x, of the member as well as the
warping, 𝜔.
kw = 1.0 restrained against rotation about x on bothmember ends; free to warp on both sides

kw = 0.7le restrained against rotation about x on both ends and warping restraint left

kw = 0.7ri restrained against rotation about x on both ends and warping restraint right

kw = 0.5 torsion and warping restraint on both member ends

kw = 2.0le restrained against rotation about x and warping 𝜔 left; right end free

kw = 2.0ri restrained against rotation about x and warping 𝜔 right; left end free

The abbreviations le and ri refer to the left and right sides. The abbreviation le always describes
the support conditions at the member start.

A lateral and torsional restraint is defined by the factors kz = 1.0 (support in y with free rotation
about z) and kw = 1.0 (restrained against torsion about x with free warping). As the internal
member model of the eigenvalue solver requires only four degrees of freedom, you need not
define any extra boundary conditions.

Comment
In the last column, you can enter your own comments for each member, for example to describe
the selected buckling lengths.

Set Input for Members No.
Below the Settings table, you find the Set input for members No. check box. If you select this
check box, the subsequent settings will be applied to the selected members or Allmembers (you
can enter the member numbers manually or select them graphically with the button). This
option is useful when you want to assign identical boundary conditions to several members (see
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000726).

With this function, you cannot change the settings you have already made.
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2.6 Effective Lengths - Sets of Members

This window controls the effective lengths for sets of members. It is only displayed when you have
selected one or more sets of members for design in the 1.1 General DataWindow (see Figure 2.2,
page 6).

Figure 2.17: Window 1.6 Effective Lengths - Sets of Members

The concept of the window is very similar to the previous 1.6 Effective Lengths - MembersWindow.
Here you can define the buckling lengths for sets of members, as described in Chapter 2.5.

There are differences, however, with respect to the parameters for torsional and lateral-torsional
buckling. Those are to be defined bymeans of boundary conditions inWindows 1.8Nodal Supports
(see Chapter 2.8) and 1.9 Member Hinges (see Chapter 2.9).

The parameters concerning buckling and torsional buckling can be defined by means of the
buckling lengths, KL, or member lengths, L. This option is controlled by the settings in the Details
dialog box, tab Stability (see Figure 3.2, page 30).
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2.7 Design Parameters

In Window 1.7, several parameters can be defined that are required for design.

Figure 2.18: Window 1.7 Design Parameters

Distance
The distance, Lv, is relevant for the shear design of round HSS sections according to [1] Section G5.
It represents the distance between the points of maximum and zero shear force.

Gross Area / Net Area
In columns C and D, the gross area, Ag, and the net area, An, of each member is listed. If required,
the net area can be modified in order to consider holes (see [1] Section B4.3b).

Shear Lag Factor
For each designed member, the shear lag factor for tension design, U, can be defined according to
[1] Table D3.1.

Effective Area
Column F lists the effective areas, Ae, which are determined according to [1] Equation D3-1 from
the net area and the shear lag factor of each member.



2 Input Data

©DLUBAL SOFTWARE 2018

21

2

2.8 Nodal Supports - Sets of Members

This window is displayed if at least one set of members has been selected for design in Window
1.1 General Data.

The stability design of each set of members is based on the alternative methods defined in [1]
Appendix 7. The respective loads and the boundary conditions are essential for the determination
of the elastic critical moment which is important to design the entire set of members.

Figure 2.19: Window 1.8 Nodal Supports - Set of Members

The current table manages the boundary conditions of the set of members that is selected in the
navigator on the left!

The supports defined in RFEMor RSTAB (for example, in Z for a continuous beam) are not relevant in
this table: The distributions ofmoments and shear forces for the determination of the elastic critical
moment are automatically imported from RFEM/RSTAB. Here, you define the support conditions
with respect to the failure modes of stability (buckling and lateral-torsional buckling).

Supports on the start and end nodes of each set of members are preset. Any other supports, for
example due to connected members, must be added manually. Use the button to select
nodes graphically in the RFEM/RSTAB work window.

In order to determine the elastic critical moment of the entire set of members, the program creates
a planar framework model with four degrees of freedom for each node.

For the nodal supports, the orientation of axes within a set of members is important. The pro-
gram checks the position of the nodes and internally defines the axes of the nodal supports for
Window 1.8 according to Figure 2.20 through Figure 2.23. The [Local Coordinate System] button
below the model graphic can help you with the orientation: Use it to display the set of members
exclusively, with the axes being clearly visible (see also Knowledge Base article on our website).

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000961
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Figure 2.20: Auxiliary coordinate system for nodal supports – straight set of members

If allmembers of a set ofmembers lie on a straight line, as shown in Figure 2.20, the local coordinate
system of the first member within this set of members is applied to entire set of members.

Figure 2.21: Auxiliary coordinate system for nodal supports – set of members in vertical plane

If the members do not lie on a straight line, they nevertheless must be located in one plane. We
can see a vertical plane in Figure 2.21. In this case, the X'-axis is horizontal and oriented in the
plane direction. The Y'-axis is horizontal as well, but perpendicular to the X'-axis. The Z'-axis points
downwards.

Figure 2.22: Auxiliary coordinate system for nodal supports – set of members in horizontal plane

If the members are located in a horizontal plane, the X'-axis is defined parallel to the X-axis of the
global coordinate system. The Y'-axis then points in the opposite direction to the global Z-axis.
The Z'-axis is parallel to the global Y-axis.

Figure 2.23: Auxiliary coordinate system for nodal supports – set of members in inclined plane

Figure 2.23 shows the general case: Themembers do not lie on a straight line, but are located in an
inclined plane. The definition of the X'-axis results from the intersection line between the inclined
and the horizontal plane. The Y'-axis is perpendicular to the X'-axis (and also perpendicular to the
inclined plane). The Z'-axis is perpendicular to the X'- and Y'-axes.
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The buttons below the graphic have the following functions:

Button Function

Shows model or schematic sketch

Shows members as 3D rendering or wire-frame model

Shows current set of members or entire model

Displays irrelevant members of model as transparent or opaque

Shows set of members with local coordinate system or entire model

Shows view in direction of X-axis

Shows view in opposite direction of Y-axis

Shows view in direction of Z-axis

Shows isometric view

Table 2.2: Buttons for graphic window

If the set of members is laterally supported in specific locations, these nodes must be added
manually in Window 1.8 Nodal Supports. In this way, it is possible to consider, for example, the
effect of a purlin which is connected in the spatial model of RFEM or RSTAB. If this support is
neglected in the reduced set of members model, instabilities may occur.

The button (see Figure 2.19) enables you to define the supported nodes graphically in the work
window of RFEM or RSTAB.

In columns B to N of the table, you specify the support conditions of the selected nodes. To
activate or deactivate the supports and restraints for the corresponding degrees of freedom, select
the check boxes. Alternatively, you can enter the constants of a translational or rotational Spring
manually.

The Support rotation and Eccentricity parameters allow for modeling support conditions close to
reality.

With the [Edit warp stiffener] button (below the table) it is possible tomake the programdetermine
the constant of a warp spring.

Figure 2.24: Dialog box Edit Warp Spring
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The following warp stiffening types are available in the Edit Warp Spring dialog box:

• End plate

• Channel section

• Angle

• Connecting column

• Cantilevered portion

Materials and cross-sections can be selected via the lists and [Library] buttons. With the button,
you can select them also graphically in the model of RFEM or RSTAB.

Based on the parameters, RF-/STEEL AISC determines the Resultingwarp spring, Cu�, which can then
be transferred to Window 1.8 with [OK].

Warping torsion with seven degrees of freedom
To analyze sets of members according to the second-order analysis for flexural-torsional buckling
with warping torsion, select the corresponding check box in theWarping Torsion tab of the Details
dialog box (see Figure 3.4, page 32). The table titles of Window 1.8 will be adjusted accordingly.

The warping analysis requires a license of the RF-/STEELWarping Torsionmodule extension.

Figure 2.25: Window 1.8 Nodal Supports - Set of Members for warping torsion with seven degrees of freedom

Define the support parameters of the set of members “extracted” from the structural model.
Supports can be specified for all nodes of the respective members. The supports defined in RFEM
or RSTAB are preset, as well as the supports on both ends of the set of members.

Lateral supports along the set of members have to be added as additional supports. In this way,
e.g. purlins connected in the spatial model can be accounted for. If this specific support is missing
in the model of the “extracted” set of members, stability problems may occur.

The supported nodes can be selected graphically with the button in the RFEM/RSTAB work
window.
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In columns B to N, the support conditions of the selected nodes can be defined. To activate or
deactivate the supports and restraints for the corresponding degrees of freedom, select or deselect
the check boxes. Alternatively, you can enter the constants of the translational and rotational
springs manually.

The Support rotation and Eccentricity parameters allow for modeling support conditions close to
reality.

2.9 Member Hinges - Sets of Members

This window is displayed if at least one set of members has been selected in the 1.1 General Data
Window. Here, you can define hinges for members within the set of members that, for structural
reasons, do not transfer the degrees of freedom locked in Window 1.8 as internal forces. Make
sure that no double hinges are generated in coaction with Window 1.8!

Figure 2.26: Window 1.9 Member Hinges

The current table manages the hinges of the set of members that is selected in the navigator on
the left.

In column B, you specify theMember Sidewhere the hinge is located, or if there are hinges on both
member sides.

In columns C to F, you can define the releases or spring constants in order to adjust the set of
members model to the support conditions defined in Window 1.8.
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Warping torsion with seven degrees of freedom
If the warping torsion with seven degrees of freedom has been selected in theWarping Torsion
tab of the Details dialog box (requires license of RF-/STEELWarping Torsionmodule extension),
additional columns are available for the specific parameters.

Figure 2.27: Window 1.9Member Hinges - Set ofMembers for warping torsion with seven degrees of freedom

2.10 Parameters - Sets of Members

This window is shownwhen the warping torsion with seven degrees of freedom has been selected
in theWarping Torsion tab of the Details dialog box (see Figure 3.4, page 32). For this specific type
of analysis, a license of RF-/STEELWarping Torsionmodule extension is required.

Figure 2.28: Window 1.10 Parameters - Sets of Members for warping torsion with seven degrees of freedom

Taking into account the boundary conditions, such as nodal supports, hinges, or load application,
RF-/STEEL AISC determines the mode shapes of each set of members before the actual design.
They are then considered accordingly.
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In column A, you can define an Initial Local Bow Imperfection that is related to the length of each
set of members. The default value, L/150, can be adjusted to account for the imperfection charac-
teristics of the model or cross-section. It will only be considered, however, if the length, L, defined
in column C is greater than zero.

The reference length, L, can be adapted when as the LManually check box is selected. In this way,
it is possible to account for lateral supports along the set of members, for example.

As the Specification [1] does not provide any specific values for imperfections, the initial bow
imperfection is disabled by means of the default length 0.00 ft.

After the design, the mode shapes can be checked graphically in theMode Shape ViewWindow
(see Figure 5.8, page 52).

2.11 Serviceability Data

The last input window controls the settings for the serviceability limit state design of specific
objects. It is available when you have selected one or more load cases or combinations in the
Serviceability Limit State tab of Window 1.1 (see Chapter 2.1.2, page 8).

Figure 2.29: Window 1.11 Serviceability Data

In Column A, you define whether the deformation refers to single members, lists of members, or
sets of members.

For a list or set ofmembers, the orientation and rotationof all containedmembersmust be identical.
This will guarantee that the components of the deformation are taken into account correctly.

In column B, you can specify the numbers of the members or sets of members that are to be
analyzed. The button enables you to select the objects graphically in the work window. In
column D, the Reference Length of each object is shown. The geometrical lengths of the members,
lists or sets of members are set by default. If necessary, you can adjust those values after having
selected theManually check box in column C.
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Column E controls the governingDirection for the deflection analysis. You can select the directions
of the local member axes y and z (or u and v for unsymmetrical cross-sections).

You can consider a Precamber,wc, in column F, if applicable. The reference to the axes is controlled
by the specification in the Details dialog box (see Figure 3.3, page 31).

The Beam Type is important for the correct reference to the limit deformations. In column G, you
can specify whether a beam or a cantilever is to be analyzed. For the latter, you can define which
end has no support.

The Details dialog box controls whether the deformations are related to the undeformed system
or the shifted ends of the members or sets of members (see Figure 3.3, page 31).
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3 Calculation

3.1 Detail Settings

Before you start the calculation, it is recommended to check the design details. You can access
the corresponding dialog box in all windows of the add-on module by clicking [Details].

The Details dialog box has the following tabs:

• Ultimate limit state

• Stability

• Serviceability

• Warping torsion

• General

3.1.1 Ultimate Limit State

Figure 3.1: Dialog box Details, tab Ultimate limit state

DesignWall Thickness of HSS
When this option is selected, the design wall thickness, t, of hollow structural sections will be taken
equal to 0.93 times the nominal wall thickness. The reduction is recommended for HSS produced
according to other standards than ASTM A1065/A1065M or ASTM A1085/A1085M (see [1] Section
B4.2).
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Shear Buckling
The Specification [1] covers the design of common cross-sections, such as I-shapes, tees, angles,
channels, box sections, etc. User-defined sections or shapes not included in the Specification are
classified as General types by the program. Nevertheless, RF-/STEEL AISC performs the design
of those sections if specific conditions are fulfilled. The shear buckling design according to [1]
Chapter G, however, represents a problem for general shapes. Due to their inexplicit geometrical
proportions, they will be excluded from this type of design.

Theoption enables you to switch thewarning 1009)Checkof shearbuckling forgeneral cross-sections
is not allowed in the result tables on or off.

Width-Thickness Ratio of Unsymmetrical Shapes
For the classification according to [1] Table B4.1b, a distinction is made between unstiffened and
unstiffened elements. General sections, such as Case 3 and Case 8 in Table B4.1a, are missing in
Table B4.1b, however. For the design of the width-to-thickness ratios of user-defined sections, the
check of unsymmetrical shapes can be activated. Then the limiting width-to-thickness ratios, 𝜆r,
can be specified for unstiffened and stiffened elements.

Limit Values for Special Cases
For a simplified design, it is possible to neglect small bending moments, axial forces, or shear
forces, as well as shear stresses due to torsion. The limit ratios of the moments, forces, or stresses
can be defined separately in this dialog box section.

The preset limits are not part of the Specification [1]. Changing the values is in the responsibility
of the user.

3.1.2 Stability

Figure 3.2: Dialog box Details, tab Stability
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Determination of Elastic Critical Moment for LTB
The elastic critical moment is calculated automatically by the Eigenvalue solver.

If there are transverse loads, it is important to define the location where those forces are acting:
Depending on the location of Load application, they can have stabilizing or destabilizing effects
due to their eccentricities. Thus, they have a major impact on the elastic critical moment. This
setting is globally applied to all loads and all sets of members of the design case.

The signs of the eccentricities are related to the shear center,M, of each cross-section. The following
article on our website provides more information about the sign convention for transverse loads:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000880

Please note that the settings are globally applied to all members and sets of members. With loads
acting in different locations, the objects can be designed in separate design cases with specific
settings (see Chapter 7.1, page 55).

Definition of Buckling Lengths
The effective lengths which are relevant for buckling and torsional buckling are managed in
Window 1.5 (for members) and Window 1.6 (for sets of members) – see Chapters 2.5 and 2.6 at
pp. 15 - 19. There are two options how to define the parameters concerning buckling and torsional
buckling: those can be referred either to the Buckling Length K*L or to theMember Length L of each
member or set of members.

Depending on the setting in theDetails dialog box, the titels of the respective columns inWindows
1.5 and 1.6 will be adapted.

3.1.3 Serviceability

Figure 3.3: Dialog box Details, tab Serviceability
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Deformation Relative To
The options below specify whether the deformations are related to the shiftedmember ends or set
of members ends (line between start and end nodes of deformedmodel) or to the undeformed
original system. The difference is illustrated by an example which you can find on our website:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001081

Serviceability Limits (Deflections)
For the SLS design, the limiting deflections can be separately defined for beams (default: L/360)
and cantilevers (default: Lc/180). Commentary Section L2 of the Specification [1] gives recommen-
dations on the maximum values for deflections.

Direction of Precamber
When you specify two directions in column E of the 1.11 Serviceability DataWindow and apply a
precamber in column F, you can determine for which direction the precamber is to be considered.

3.1.4 Warping Torsion

This tab allows for settings of the torsional analysis for sets of members. You can access the entries
when the RF-/STEELWarping Torsionmodule extension has been licensed.

Figure 3.4: Dialog box Details, tabWarping Torsion
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RF-/STEELWarping Torsion
If you want RF-/STEEL AISC to perform a Calculation according to Steel Design Guide 9 [2], select the
check box.

The determination of torsional stresses and their combination with stresses due to bending and
axial load is described in [2] Chapter 4. In the method with seven degrees of freedom, the stability
calculation is carried out according to the second-order analysis for flexural-torsional buckling
taking into account warping torsion and imperfections affine to mode shapes.

The degrees of freedom concerning the displacements and rotations in and about the three axes
X', Y', Z' as well as warping can be defined in Window 1.8 (see Figure 2.25, page 24) andWindow 1.9
(see Figure 2.27, 26).

In Window 1.10, an initial local bow imperfection can be specified (see Figure 2.28, page 26).

When theWarping Torsion option has been selected, Window 1.6 Effective Lengths - Sets ofMembers
is not shown. The parameters are to be defined in the specific Windows 1.8 through 1.10 instead.

The warping analysis is performed iteratively, with the stiffness matrix K changing due to already
computed internal forces and deformations.

On our website, you can find an example illustrating the design with seven degrees of freedom:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001544

You can also watch a webinar which includes the warping torsion design of a steel frame:
https://www.dlubal.com/en-US/support-and-learning/learning/webinars/000270

Method ofWarping Analysis
Aside from a Second-order analysis, the warping analysis of the sets of members can be carried out
by means of a Linear approach. This linear geometric analysis makes it is possible to mimimize the
effects of the overall stability behavior and focus on the effects of warping instead.

Load Application
The point of Load Application is significant for the stability analysis with seven degrees of freedom.
Depending on this location, the load has an either stabilizing or destabilizing effect on the stability
characteristics.

There are nine options available to define the location where the load is applied on the cross-sec-
tion. In the sketch of the section, the selected point is highlighted in red.
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3.1.5 General

Figure 3.5: Dialog box Details, tab General

Cross-Section Optimization
By default, the optimization is targeted on the maximum design ratio of 100%. If required, you
can change this limit value.

Check of Maximum Effective Slenderness Ratio
According to [1] User Note to Section D1, the slenderness ratio, KL / r, preferably should not exceed
300 for members in tension. For members in compression or flexure, the slenderness ratios should
not exceed 200 (cf. [1] Section E2). If required, the limit ratios can be adjusted.

The limit ratios are compared to the real member slendernesses in Window 3.3. That window is
available after the calculation (see Chapter 4.8, page 43) when the corresponding option has been
checked in the Display Result Windows section of the Details dialog box.

Display Result Windows
In this dialog section, you can select which result windows including parts list are to be displayed
in the output. Those windows are described in Chapter 4.

Window 3.3 Member Slendernesses is deactivated by default.
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3.2 Starting Calculation

In all input windows of RF-/STEEL AISC, you can start the design via the [Calculation] button.

The add-on module searches for the results of the load cases, load combinations, and result
combinations that are to be designed. If they are not available yet, RF-/STEEL AISC starts the
calculation in RFEM or RSTAB to determine the relevant internal forces.

You can also start the calculation in the RFEM or RSTAB user interface: The To Calculate dialog box
(menu Calculate → To Calculate) lists the design cases of the add-on modules like load cases or
load combinations.

Figure 3.6: Dialog box To Calculate

If the RF-/STEEL AISC design cases are missing in the Not Calculated section, select All or Add-on
Modules in the drop-down list below the list.

To transfer the selected RF-/STEEL AISC cases to the list on the right, use the button. Then,
click [OK] to start the calculation.

You can also calculate a design case directly by using the list in the toolbar: Set the RF-/STEEL AISC
case and click the [Show Results] button.

Figure 3.7: Direct calculation of an RF-STEEL AISC design case in RFEM

Subsequently, you can follow the calculation in a separate dialog box.
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4 Results
Window 2.1 Design by Load Case appears immediately after the calculation.

Figure 4.1: Result window with design results and details

The designs results are shown in Windows 2.1 to 2.5, sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces, Window 3.3 gives information on the
member slendernesses. The last two Windows 4.1 and 4.2 show the parts lists of members and
sets of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the
previous or next input window, use the buttons shown on the left. You can also use the function
keys to select the next [F2] or previous [F3] window.

[OK] saves the results. RF-/STEEL AISC is closed and you return to the main program.

Chapter 4 describes the different result windows one by one. The evaluation and checking of the
results is described in Chapter 5 starting on page 46.
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4.1 Design by Load Case

The upper part provides a summary of the results, sorted by load case, load and result combina-
tions of the governing designs. Furthermore, the list is split into Ultimate Limit State Design and
Serviceability Limit State Design results.

The Details section below includes specific information on the cross-section properties, internal
forces, and design parameters for the load case or combination selected in the upper table.

Figure 4.2: Window 2.1 Design by Load Case

Description
This column shows the descriptions of each designed load case, load or result combination.

Member No.
In this column, the number of each member is given that has the maximum design ratio of the
respective loading.

Location x
The column shows the x-location of each member where the maximum design ratio occurs. For
the tabular output, the program uses the following member locations x:

• Start and end nodes

• Division points according to optionally defined member divisions (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member divisions according to specification for member results (see RFEM/RSTAB dialog box
Calculation Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces
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Design Ratio
Columns D and E show the design conditions according to [1].

The lengths of colored bars represent the respective design ratios.

Design According to Formula
This column lists the references of the Standard [1] according towhich the different types of design
have been performed.

DS
The last column provides information on the respective design situations.

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

This window lists the maximum ratios of all members and loadings selected for design, sorted by
cross-section. For each section, the results are given for cross-section design, stability analysis, and
serviceability limit state design.

If there is a tapered member, the cross-sections of the member start and end are listed separately.
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4.3 Design by Set of Members

Figure 4.4: Window 2.3 Design by Set of Members

This result window is displayed when you have selected at least one set of members for the design.
It lists the maximum design ratios sorted by set of members.

TheMember No. column shows the number of themember within the set which has themaximum
ratio with respect to the specific design criterion.

The output by set of members clearly presents the design for an entire structural group, e.g. a
frame.



4 Results

©DLUBAL SOFTWARE 2018

40

4

4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

This result window lists the maximum ratios of the individual designs for each member. The
columns are described Chapter 4.1 on page 37.

4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location
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This result window lists the maxima for each member at all locations x resulting from the division
points in RFEM or RSTAB:

• Start and end nodes

• Division points according to optionally defined member division (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member divisions according to specification for member results (see RFEM/RSTAB dialog box
Calculation Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces

4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For all designedmembers, the internal forces are listed that effectuate themaximum ratios of each
type of design.

Location x
This column shows the x-locations where the maximum design ratios occur.

Loading
This column displays the numbers of the load case, load or result combination whose internal
forces result in the maximum design ratios.

Forces / Moments
For each member, these columns present the axial and shear forces as well as the torsional and
bendingmoments which give themaximum ratios in the respective cross-section designs, stability
analyses, and serviceability limit state designs.
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Design According to Formula
The final column informs you about the design types and equations by which the designs have
been performed according to the Standard [1].

4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

For each set of members, this window shows the internal forces that result in themaximum design
ratios. The respective equations according to [1] are referred to in the last column.
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4.8 Member Slendernesses

Window 3.3 is shown when you have selected the respective check box in the Details dialog box
(see Figure 3.5, page 34).

Figure 4.9: Window 3.3 Member Slendernesses

The table lists the effective slenderness ratios of the designed members for both directions of the
principal axes. They are determined in compliance with the load type.

Below the list, you find a comparison of the most unfavorable values with the limit values that
have been defined in the Details dialog box (see Figure 3.5, page 34).

Members of the types ‘tension' or ‘cable' are not included in this table.

This window is only informative. It does not provide any stability analysis of slendernesses.
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4.9 Parts List byMember

Finally, RF-/STEEL AISC provides a summary of all cross-sections contained in the design case.

Figure 4.10: Window 4.1 Parts List byMember

By default, this list contains only the designed members. If you need a parts list for all members of
the model, select the corresponding option in the Details dialog box (see Figure 3.5, page 34).

Part No.
The program automatically assigns item numbers to members with identical features.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
Column B shows howmany similar members are used for each part.

Length
This column shows the respective length of an individual member.

Total Length
In this column, the product determined from the two previous columns is given.

Surface Area
For each item, the program gives the surface area relative to the total length. This area is deter-
mined from the Surface Area of the cross-sections. It can be checked in Windows 1.3 and 2.1 to 2.5
in the cross-section properties (see Figure 2.11, page 13).
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Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The unit mass of a cross-section is related to the length of one meter. For tapered sections, the
program averages both cross-section masses.

Weight
The values of this column represent the products of the entries in columns C and G.

Total Weight
The final column gives the total mass of each sectional part.

Sum
At the end of the list, you find a summary of the values in the columns B, D, E, F, and I. The last row
of the Total Weight column shows the total amount of required steel.

4.10 Parts List by Set of Members

Figure 4.11: Window 4.2 Parts List by Set of Members

The last result window is displayed when you have selected at least one set of members for design.
It represents the parts list of structural groups, for example horizontal beams.

Details on the various columns can be found in Chapter 4.9. If a set ofmembers consists of different
cross-sections, the program averages the surface area, volume, and cross-section weight.
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5 Results Evaluation
You can evaluate the results in different ways. For this, the buttons below the tables are very useful.

Figure 5.1: Buttons for results evaluation

The buttons have the following functions:

Button Description Function

Mode Shape
OpensMode Shape ViewWindow showing buckling shape
→ Chapter 5.4, page 52

Ultimate Limit
State Design

Shows or hides the results of the ULS design

Serviceability Limit
State Design

Shows or hides the results of the SLS design

Result Combination
Creates a new result combination from the governing load
cases and load combinations

Color Bars Shows or hides the colored relation scales in the tables

Filter Parameters
Describes the filter criterion for the output in the tables:
Design ratios greater than 1, maximum value, or user-defined
limit

Apply Filter
Displays only rows where the filter parameters are valid
(ratio > 1, maximum, user-defined limit)

Result Diagrams
Opens the Result Diagram onMemberWindow
→ Chapter 5.2, page 50

Excel Export
Exports the table to MS Excel
→ Chapter 7.4.3, page 60

Member Selection
Option to select a member graphically to display its results in
the table

View Mode
Jumps to the work window of RFEM or RSTAB to view objects
in model

Table 5.1: Buttons in Windows 2.1 to 2.5
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5.1 Results in RFEM/RSTABModel

You can also evaluate the design results in the work window of RFEM or RSTAB.

Background graphic and viewmode
The work window of RFEM or RSTAB in the background is useful for you to find the location of a
particular member in the model: There, the member selected in the RF-/STEEL AISC result window
is highlighted. Furthermore, an arrow indicates the relevant location x on this member.

Figure 5.2: Indication of member and relevant Location x in RFEMmodel

If you cannot improve the display by moving the RF-/STEEL AISC module window, click the
button to activate the viewmode. Thus, you hide the module window so that you can change the
view in the user interface of RFEM or RSTAB. In the viewmode, you can use the functions of the
Viewmenu, e.g. zoom, move, or rotate the view. The arrow will remain visible when doing so.

Click [Back] to return to the RF-/STEEL AISC module.
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RFEM/RSTABwork window
You can also check the design ratios graphically in the RFEM/RSTAB model: Click [Graphics] to quit
the design module. In the work window of RFEM or RSTAB, the design ratios are now displayed
like the internal forces of a load case.

In the Results navigator, you can select whether the ratios of the ULS and/or SLS designs are to be
displayed.

Figure 5.3: Results navigator for Ultimate Limit State and Serviceability Limit State designs

To turn the display of the design ratios on or off, use the [Show Results] button which is familiar
from the display of internal forces. To switch the result values on or off, click the [Show Values]
button next to it.

The tables of RFEM or RSTAB are of no relevance for the steel design results.

You can set the relevant RF-/STEEL AISC design case in the list of the toolbar.

The graphical representation of the design results can be controlled in the Display navigator, item
Results → Members. The ratios are shown Two-Colored by default.

Figure 5.4: Display navigator: Results→Members
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When you have selected a multicolor display (optionsWith/Without Diagram or Cross-Sections),
the color panel is available. It provides the common control functions which are described in the
RFEM/RSTAB manual, Chapter 3.4.6.

Figure 5.5: Design ratios with display optionWithout Diagram

The graphics of the design results can be transferred to the printout report (see Chapter 6.2,
page 54).

To return to the add-on module, use the [RF-/STEEL AISC] button in the panel.
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5.2 Result Diagram

You can graphically evaluate the design ratios in a result diagram, without using the work window
of RFEM or RSTAB.

Select the member (or set of members) in the RF-/STEEL AISC result window by clicking in the
relevant table row. Then click the button to open the Result Diagram onMember dialog box.
This button is located below the upper table (see Figure 5.1, page 46).

If you want to open the result diagram in the work window of RFEM or RSTAB, select the menu

Results → Result Diagrams for SelectedMembers

or the toolbar button shown on the left.

A new window opens. It presents the distribution of the maximum design values on the member
or set of members.

Figure 5.6: Dialog box Result Diagram onMember

You can switch the ULS and SLS results on or off in the Results navigator.

Use the list in the toolbar to select the relevant RF-/STEEL AISC design case.

The Result Diagram onMember dialog box is described in the RFEM or RSTAB manual, Chapter 9.5.
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5.3 Filter for Results

The RF-/STEEL AISC result windows allow you to sort the results by various criteria. In addition, you
can use the filter options for the tables (see Figure 5.1, page 46) to reduce the numerical output
according to specific ratios. This function is described in the Knowledge Base on our website:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000733

Furthermore, you can apply the filter options described in Chapter 9.9 of the RFEM manual or
Chapter 9.7 of the RSTAB manual to evaluate the results graphically.

You can also use the Visibility options for RF-/STEEL AISC to filter the members and evaluate them
(see RFEMmanual, Chapter 9.9.1 or RSTAB manual, Chapter 9.7.1).

Filtering design ratios
The design ratios can be used as filter criteria in the RFEM/RSTAB work window which you access
by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is not, select.

View → Control Panel (Color scale, Factors, Filter)

or use the toolbar button shown on the left.

The panel is described in the RFEM/RSTAB manual, Chapter 3.4.6. The filter settings for the results
can be defined in the first tab (Color scale). As this tab is not available for the two-colored results
display, you have to set the display option ColoredWith/Without Diagram or Cross-Sections in the
Display navigator (see Figure 5.4, page 48).

As seen in the figure to the left, the color spectrum can be set in such a way that only ratios greater
than 0.50 are shown in the color ranges between blue and red.

Filteringmembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results exclusively, i.e. filtered. This function is described in the RFEMmanual, Chapter 9.9.3
or RSTAB manual, Chapter 9.7.3.

Figure 5.7: Filtering design ratios of one frame

Unlike the Visibility function, the entire model is displayed. Figure 5.7 shows the design ratios of
one frame only. All other members are displayed in the model, but they have no design results.
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5.4 Mode Shapes

The mode shapes of the members and sets of members can be checked graphically in a separate
window: Go to the relevant object in the result window, and then select its results row of Lateral
torsion buckling (for members) or Set of members - Stability analysis (for sets of members).

Then click the [Mode Shapes] button which is located below the upper table.

Figure 5.8: Mode shape of a set of members

The mode shapes are created automatically when the elastic critical moment is determined. They
are not available in numerical form, however, only graphically.

The buttons below the graphic are described in Table 2.2 on page 23. Use the Display factor next
to the buttons to scale the representation of the mode shape.

The following Knowledge Base article on our website illustrates howmode shapes can be used:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001483
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6 Printout

6.1 Printout Report

Similarly to RFEM or RSTAB, the program generates a printout report for the RF-/STEEL AISC results.
It can be supplemented by graphics and descriptions. The selection in the printout report controls
which data of the design module are included in the final printout.

The printout report is described in the RFEM or RSTAB manual. In particular, Chapter 10.1.3.5
Selecting Data of Add-on Modules describes how the input and output data of add-on modules
can be selected.

Figure 6.1: Selecting designs and intermediate results in printout report

Click the [Details] button when you want to include all or specific intermediate results in the
printout report. They can be documented in a Short (compact list) or Long (descriptive list) form.

If you work on complex models featuring many design cases, you can split the data into several
printout reports. This allows for a clearly arranged documentation.
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6.2 Graphic Printout

In RFEM or RSTAB, you can add any picture of the work window to the printout report or send it
directly to the printer. In this way, the design ratios shown on the RFEM/RSTAB model can be used
for the documentation.

The printing of graphics is described in the RFEM or RSTAB manual, Chapter 10.2.

To print the currently displayed graphic of the design ratios, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.2: [Print Graphic] button in RFEM toolbar

The Graphic Printout dialog box appears.

Figure 6.3: Dialog box Graphic Printout, tab General

The dialog box is described in the RFEMor RSTABmanual, Chapter 10.2. This chapter also describes
the other tabs of the dialog box.

You canmove a graphic anywhere within the printout report by using the drag-and-drop function.

If youwant tomodify an image in the printout report, right-click the relevant entry in the navigator
of the printout report. The Properties option in the shortcut menu opens the Graphic Printout
dialog box again. It offers you several options to adjust the image.
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7 General Functions
This chapter describes the menu functions and export options for the design results.

7.1 Design Cases

Design cases allow you to arrange members for specific analyses. In this way, you can combine
groups of structural components or analyze members with particular design specifications, e.g.
modified materials, cross-sections, strength design, or optimization parameters.

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-/STEEL AISC design case, you can also use the load case list in the toolbar of RFEM
or RSTAB.

Create design case
To create a new design case, use the RF-/STEEL AISC menu and select

File → New Case.

The following dialog box appears.

Figure 7.1: Dialog box New RF-STEEL AISC Case

Enter a No. (one that is still available) for the new design case and an optional Description. It
facilitates the selection in the load case list.

Then click [OK] to open the 1.1 General DataWindow of RF-/STEEL AISC where you can enter the
data of the new design case.

Rename design case
To change the description of a design case, use the RF-/STEEL AISC menu and select

File → Rename Case.

The following dialog box appears.

Figure 7.2: Dialog box Rename RF-STEEL AISC Case

You can specify a different Description as well as a different No. for the design case.
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Copy design case
To copy the input data of the current design case, use the RF-/STEEL AISC menu and select

File → Copy Case.

The following dialog box appears.

Figure 7.3: Dialog box Copy RF-STEEL AISC Case

Define the No. and, if necessary, a Description of the new case.

Delete design case
To delete a design case, use the RF-/STEEL AISC menu and select

File → Delete Case.

The following dialog box appears.

Figure 7.4: Dialog box Delete Cases

Select the design case in the list of Available Cases. To delete this case, click [OK].



7 General Functions

©DLUBAL SOFTWARE 2018

57

7

7.2 Cross-Section Optimization

The design module offers you the option to optimize overstressed or little utilized cross-sections.
Open the drop-down list in column D resp. E in Window 1.3 Cross-Sections (see Figure 2.9, page 11)
and select the optimization option From current row.

You can also start the optimization in the result windows via the shortcut menu.

Figure 7.5: Shortcut menu to Optimize Cross-Section

During the optimization, the module determines the section that fulfills the analysis requirements
in the “optimal” way, i.e. comes as close as possible to the maximum allowable design ratio
specified in theDetails dialog box (see Figure 3.5, page 34). The required cross-sectional properties
are calculated with the internal forces of RFEM or RSTAB. If a different cross-section proves to be
more favorable, it will be used for the design. In this case, the graphic in Window 1.3 shows two
cross-sections – the original section from RFEM or RSTAB and the optimized one (see Figure 7.7).

When you optimize a parametric cross-section, the following dialog box appears:

Figure 7.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section: Optimize

By selecting the check box(es) in the Optimize column, you decide which parameter(s) you want
to modify. They activate theMinimum andMaximum columns where you can specify the upper
and lower limits of each parameter. The Increment column controls the interval in which the value
of the parameter varies during the optimization.
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If you want to Keep current side proportions, select the corresponding check box. In addition, you
have to select at least two parameters for the optimization.

Cross-sections composed of combined rolled cross-sections cannot be optimized.

Please note that the optimization does not recalculate the internal forces with the modified
cross-sections: It is up to you to decide which sections should be transferred to RFEM or RSTAB for
a new analysis. As a result of optimized cross-sections, the internal forces may vary considerably
because of the changed stiffnesses of the model. Therefore, it is recommended to recalculate the
internal forces resulting from the modified cross-sections after the first optimization, and then to
optimize the sections once again.

To export the modified cross-section(s) to RFEM or RSTAB, go to Window 1.3 Cross-Sections and
select

Edit → Export All Cross-Sections to RFEM/RSTAB.

You can also use the shortcut menu in Window 1.3 to export one or all optimized cross-sections to
RFEM or RSTAB.

Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections

Before the modified cross-sections are transferred to RFEM or RSTAB, a confirmation is required as
to whether the RFEM/RSTAB results should be deleted.

Figure 7.8: Confirmation when exporting cross-sections

By approving the confirmation and starting the [Calculation] in the RF-/STEEL AISC module, the
internal forces of RFEM or RSTAB as well as the design ratios will be determined in one single
calculation run.

If the modified cross-sections have not been exported to RFEM or RSTAB yet, you can reimport the
original sections in the design module by using the last two menu options shown in Figure 7.7.
Please note that this shortcut menu is only available in Window 1.3 Cross-sections.

When optimizing a taperedmember, the programmodifies the cross-sections of themember start
and member end. For the intermediate locations, the secondmoments of area are linearly inter-
polated. Since those values are considered with the fourth power, the designs may be inaccurate
if the depths of the start and end cross-sections differ considerably. It is then recommended to
divide the taper into several members, thus modeling the taper layout manually.
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7.3 Units and Decimal Places

The units and decimal places of RFEM or RSTAB and of all add-on modules are managed in one
dialog box. To define the units for RF-/STEEL AISC, select

Settings → Units and Decimal Places.

The dialog box which is familiar from RFEM or RSTAB appears. RF-/STEEL AISC is preset in the
Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

You can save the settings as a user-defined profile to reuse them in other models. Those functions
are described in the RFEM or RSTAB manual, Chapter 11.1.3.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM/RSTAB

If you havemodified thematerials in RF-/STEEL AISC for the design, you can export thosematerials
to RFEM or RSTAB in a similar way as you export cross-sections: Open the 1.2 MaterialsWindow
and then select

Edit → Export All Materials to RFEM/RSTAB.

You can also export the modified materials to RFEM or RSTAB by using the shortcut menu in
Window 1.2.

Figure 7.10: Shortcut menu of Window 1.2 Materials

Before the modified materials are transferred to RFEM or RSTAB, a confirmation is required as to
whether the results of the main program should be deleted. When you approve this confirmation
and then start the [Calculation] in RF-/STEEL AISC, the new internal forces and design ratios will be
determined in one single calculation run.

If the modified materials have not been exported to RFEM or RSTAB yet, you can transfer the
original materials to the designmodule via the last twomenu options shown in Figure 7.10. Please
note that this shortcut menu is only available in Window 1.2 Materials.

7.4.2 Exporting Effective Lengths to RFEM/RSTAB

If you have adjusted the effective lengths in RF-/STEEL AISC for the design, you can export the
modified values to RFEM or RSTAB in a similar way as you export cross-sections: Go to Window
1.5 Effective Lengths - Members and then select

Edit → Export All Effective Lengths to RFEM/RSTAB.

You can also use the corresponding option on the shortcut menu of Window 1.5.

Figure 7.11: Shortcut menu of Window 1.5 Effective Lengths - Members

Before the modified effective lengths are transferred to RFEM or RSTAB, a confirmation has to be
approved as to whether the results of the main program should be deleted.

7.4.3 Exporting Results

The RF-/STEEL AISC results can also be used by other programs.

Clipboard
To copy cells selected in the result windows to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example, in a word processing program. The headers of the table columns
will not be transferred.
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Printout Report
You can print the data of RF-/STEEL AISC to the printout report (see Chapter 6.1, page 53). To
export the tables and graphics, then select the printout report menu

File → Export to RTF.

The function is described in the RFEM or RSTAB manual, Chapter 10.1.11.

Excel
RF-/STEEL AISC provides a function for the direct data export to MS Excel or the CSV file format. To
open the corresponding dialog box, select

File → Export Tables.

Figure 7.12: Dialog box Export of Tables

When you have selected the relevant options, you can start the export by clicking [OK]. Excel will
be started automatically, i.e. you do not have to open the program before.

Figure 7.13: Results in Excel
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8 Example
Columnwith Compression and Biaxial Bending
This example illustrates the stability design of a columnwith regard to flexural buckling and lateral
torsional buckling. Furthermore, the interaction of flexure and compression is examined. The
analysis follows the Load Resistance Factor Design provisions.

8.1 Design Values

Model and loads

Figure 8.1: Model and loads

Material: Steel A992

Design values of loads:
P = 65.0 kip
w = 0.5 kip/ft
V = 2.0 kip

Internal forces due to linear analysis

P My Mz Vy Vz
Figure 8.2: Internal forces
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Design location
The design proceeds according to x-locations, i.e. for specific positions x of the member. The
governing location is at x = 7 ft at the centerline of themember, with the following internal forces:

P = –65.00 kip My = 12.25 kipft Mz = 7.00 kipft Vy = 1.00 kip Vz = 0.00 kip

8.2 Cross-Section Properties - W 8x28

Cross-Section Property Symbol Value Unit

Gross area Ag 7.08 in2

Moment of inertia about major principal axis Iy 82.70 in4

Moment of inertia about minor principal axis Iz 18.30 in4

Radius of gyration about major principal axis ry 3.42 in

Radius of gyration about minor principal axis rz 1.61 in

Cross-section weight wt 24.11 lb/ft
Torsional constant J 0.35 in4

Warping constant Cw 259.00 in6

Elastic section modulus about major axis Sy 20.90 in3

Elastic section modulus about minor axis Sz 5.63 in3

Plastic section modulus about major axis Zy 23.10 in3

Plastic section modulus about minor axis Zz 8.57 in3

8.3 Material Properties - A992

Material Property Symbol Value Unit

Modulus of elasticity E 29,000 ksi

Shear modulus G 11,200 ksi

Yield strength Fy 50 ksi
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8.4 Classification of Cross-Section

Compression – [1] Table B4.1a

Flange

Case 1: Flanges of rolled I-shaped sections

b = 3.25 in

t = 0.375 in

b/t = 3.25
0.375

= 8.67

𝜆r = 0.56√
E
Fy

= 0.56√29,000
50

= 13.49

8.67 ≤ 13.49 → nonslender

Web

Case 5: Webs of doubly symmetric rolled I-shaped sections

b = 6.125 in

t = 0.25 in

b/t = 6.125
0.25

= 24.50

𝜆r = 1.49√
E
Fy

= 1.49√29,000
50

= 35.88

24.50 ≤ 35.88 → nonslender

⇒ The section is a nonslender-element section.

Flexure – [1] Table B4.1b

Flange

Case 10: Flanges of rolled I-shaped sections

b = 3.25 in

t = 0.375 in

b/t = 3.25
0.375

= 8.67

𝜆p = 0.38√
E
Fy

= 0.38√29,000
50

= 9.15

𝜆r = 1.0√
E
Fy

= 1.0√29,000
50

= 24.08

8.67 ≤ 9.15 → compact
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Web

Case 15: Webs of doubly symmetric rolled I-shaped sections

ℎ = 6.125 in

tw = 0.25 in

ℎ/tw = 6.125
0.25

= 24.50

𝜆p = 3.76√
E
Fy

= 3.76√29,000
50

= 90.55

𝜆r = 5.70√
E
Fy

= 5.70√29,000
50

= 137.27

24.50 ≤ 90.55 → compact

⇒ The section is a compact-element section.

Classification in RF-/STEEL AISC

Figure 8.3: Classification in RF-/STEEL AISC
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8.5 Design for Compression

8.5.1 Flexural Buckling about y-Axis (Major Principal Axis)

Member slenderness:

Ky L

ry
= 1.0 ⋅ 168.00

3.42
= 49.12

Limit of slenderness according to Section E3:

4.71√
E
Fy

= 4.71√29,000
50

= 113.43

49.12 ≤ 113.43

Elastic buckling stress according to Equation E3-4:

Fe = 𝜋2 E

(
Ky L
ry

)
2 = 𝜋2 ⋅ 29,000

(1.0 ⋅ 168.00
3.42 )

2 = 118.61 ksi

Critical stress according to Equation E3-2:

Fcr = ⎛⎜⎜
⎝
0.658

Fy
Fe ⎞⎟⎟

⎠
Fy = (0.658

50
118.61) ⋅ 50 = 41.91 ksi

Nominal compressive strength according to Equation E3-1:

Pn = Fcr Ag = 41.91 ⋅ 7.08 = 296.72 kip

Design compressive strength according to Section E1:

𝜙 Pn = 0.9 ⋅ 296.72 = 267.05 kip

Design ratio according to Equation B3-1:

𝜂 = P
𝜙 Pn

= 65.00
267.05

= 0.24 ≤ 1.00 ⇒ OK

Buckling design in RF-/STEEL AISC

Figure 8.4: Design details in RF-/STEEL AISC (check no. 301)
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8.5.2 Flexural Buckling about z-Axis (Minor Principal Axis)

Member slenderness:

Kz L
rz

= 1.0 ⋅ 168.00
1.61

= 104.35

Limit of slenderness according to Section E3:

4.71√
E
Fy

= 4.71√29,000
50

= 113.43

104.35 ≤ 113.43

Elastic buckling stress according to Equation E3-4:

Fe = 𝜋2 E

(Kz L
rz

)
2 = 𝜋2 ⋅ 29,000

(1.0 ⋅ 168.00
1.61 )

2 = 26.29 ksi

Critical stress according to Equation E3-2:

Fcr = ⎛⎜⎜
⎝
0.658

Fy
Fe ⎞⎟⎟

⎠
Fy = (0.658

50
26.29) ⋅ 50 = 22.56 ksi

Nominal compressive strength according to Equation E3-1:

Pn = Fcr Ag = 22.56 ⋅ 7.08 = 159,72 kip

Design compressive strength according to Section E1:

𝜙 Pn = 0.9 ⋅ 159.72 = 143.75 kip

Design ratio according to Equation B3-1:

𝜂 = P
𝜙 Pn

= 65.00
143.75

= 0.45 ≤ 1.00 ⇒ OK

Buckling design in RF-/STEEL AISC

Figure 8.5: Design details in RF-/STEEL AISC (check no. 311)
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8.6 Design for Flexure

According to the classification of the compact section (see Chapter 8.4), the limit states of yielding
and lateral-torsionsal buckling are to be analyzed for flexure about the major axis (see [1], Table
User Note F1.1). For flexure about the minor axis, the limit states of yielding and flange local
buckling are relevant.

8.6.1 Flexure about y-Axis (Major Principal Axis)

8.6.1.1 Yielding

Nominal flexural strength according to Equation F2-1:

Mn = Mp = Fy Zy = 50 ⋅ 23.10 = 1,155 kipin = 96.25 kipft

Design flexural strength according to Section F1:

𝜙b Mn = 0.9 ⋅ 96.25 = 86.63 kipft

Design ratio according to Equation B3-1:

𝜂 =
My

𝜙b Mn
= 12.25

86.63
= 0.14 ≤ 1.00 ⇒ OK

Yielding design in RF-/STEEL AISC

Figure 8.6: Design details in RF-/STEEL AISC (check no. 111)

8.6.1.2 Lateral-Torsional Buckling

Lateral-torsional buckling modification factor according to Equation F1-1:

Cb = 12.5Mmax

2.5Mmax + 3MA + 4MB + 3MC
= 12.5 ⋅ 12.25

2.5 ⋅ 12.25 + 3 ⋅ 9.16 + 4 ⋅ 12.25 + 3 ⋅ 9.16
= 1.14

Limiting laterally unbraced length for limit state of yielding according to Equation F2-5:

Lp = 1.76 rz√
E
Fy

= 1.76 ⋅ 1.61√29,000
50

= 68.24 in = 5.69 ft

Limiting unbraced length for limit state of lateral-torsional buckling according to Equation F2-6:

Lr = 1.95 rts
E

0.7 Fy

√√√

⎷

J c
Sy ℎo

+
√√√

⎷
( J c
Sy ℎo

)
2

+ 6.76(
0.7 Fy
E

)
2

= 1.95⋅1.81⋅ 29,000
0.7 ⋅ 50

√√√
⎷

0.35 ⋅ 1.0
20.9 ⋅ 7.5

+ √(0.35 ⋅ 1.0
20.9 ⋅ 7.5

)
2

+ 6.76(0.7 ⋅ 50
29,000

)
2

= 228.11 in = 19.00 ft

where rts = √√Iz Cw
Sy

= √
√
18.30 ⋅ 259.00

20.90
= 1.81 in
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Limit state of lateral-torsional buckling according to Equation F2-2:

Lb = 14 ft

Lp < Lb ≤ Lr

Nominal flexural strength according to Equation F2-2:

Mn = Cb [Mp − (Mp − 0.75 Fy Sy) (
Lb − Lp
Lr − Lp

)] ≤ Mp

Mn = 1.14 [1,155 − (1,155 − 0.7 ⋅ 50 ⋅ 20.90) ( 14 ⋅ 12 − 68.24
228.11 − 68.24

)] ≤ 1,155 kipin

Mn = 1,015.44 kipin = 84.62 kipft ≤ Mp

Design flexural strength according to Section F1:

𝜙b Mn = 0.9 ⋅ 84.62 = 76.16 kipft

Design ratio:

𝜂 =
My

Mr
= 12.25

76.16
= 0.16 ≤ 1.00 ⇒ OK

Lateral-torsional buckling design in RF-/STEEL AISC
The lateral-torsional buckling design in RF-/STEEL AISC is based on an eigenvalue analysis. Hence,
the analytical solution described above is not reflected in the Details table. As can be seen in
Figure 8.7, the design ratio is in adequate accordance with the analytical solution. To determine
the elastic critical moment,Mcr, a destabilizing effect of the transverse loads was assumed in the
Details settings for stability.

Figure 8.7: Design details in RF-/STEEL AISC (check no. 115)

8.6.2 Flexure about z-Axis (Minor Principal Axis)

8.6.2.1 Yielding

Nominal flexural strength according to Equation F6-1:

Mn = Mp = Fy Zz ≤ 1.6 FySz

Mn = 50⋅8.57 = 428.5kipin = 35.71kipft ≤ 1.6 FySz = 1.6⋅50⋅5.63 = 450.4kipin = 37.53kipft

Design flexural strength according to Section F1:

𝜙b Mn = 0.9 ⋅ 35.71 = 32.14 kipft

Design ratio according to Equation B3-1:

𝜂 = Mz

𝜙b Mn
= 7.00

32.14
= 0.22 ≤ 1.00 ⇒ OK
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Yielding design in RF-/STEEL AISC

Figure 8.8: Design details in RF-/STEEL AISC (check no. 112)

8.6.2.2 Flange Local Buckling

According to Section F6.2(a), the limit state of flange local buckling does not apply for sections
with compact flanges.

Flange local buckling design in RF-/STEEL AISC

Figure 8.9: Design details in RF-/STEEL AISC (check no. 124)

8.7 Design for Combined Forces

Finally, the interaction of flexure and compression is examined according to Section H1.

Limit for required axial strength according to Equation H1-1a:

Pr
Pc

= 65.00
143.75

= 0.45 ≥ 0.2

Design for combined forces according to Equation H1-1a:

Pr
Pc

+ 8
9

(
My

Mc,y
+ Mz

Mc,z
) ≤ 1.0

65.00
143.75

+ 8
9

(12.25
76.16

+ 7.00
32.14

) = 0.45 + 8
9

(0.16 + 0.22) = 0.79

Design ratio:

0.79 ≤ 1.00 ⇒ OK

Design for combined forces in RF-/STEEL AISC

Figure 8.10: Design details in RF-/STEEL AISC (check no. 332)
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Warping analysis . . . . . . . . . . . . . . . . . . . . . . . . .32
Warping length factor . . . . . . . . . . . . . . . . . . . . 18
Warping torsion . . . . . . . . . . . . . . . .24, 26, 32, 33
Weight . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45
Width-to-thickness ratio . . . . . . . . . . . . . . . . . .30
Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
Work window . . . . . . . . . . . . . . . . . . . . . 47, 48, 51
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